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MakerGear M2 V4 Rev. E Dual Extruder
Installation Guide





























Tools Needed

1.5 mm hex wrench (M2)
2 mm hex wrench (M2.5)
2.5 mm hex wrench (M3)
3 mm hex wrench (M4)

Snips to cut plastic ties
Exacto Knife
Masking Tape 
Phillips Head Screwdriver
Small Flat Head Screwdriver
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DISCONNECT THE M2 FROM THE POWER SUPPLY PRIOR TO STARTING.
[image: ]Check the parts list to make sure everything is included before starting.

Remove the Single Extruder 

Remove the Fan Assembly 
1. Disconnect the red fan wires from the Harness in the Wiring Bracket -        (F0 & F1).
2. Remove the M3x40 screw from the lower left hole of the Extruder Fan to remove the Fan assembly.   
(You will not need this assembly for the dual extruder setup.) 

[image: ]Remove the Filament Drive 

3. Disconnect the Thermistor (Ext) and Heater (H0) wires from the Harness in the Wiring Bracket. 
4. Remove the (2) M3x25 screws holding the Filament Drive in place.
5. Carefully clip the zip tie attaching the Hot End wires to the Filament Drive.  Remove the Filament Drive.  Remove the Hot End by loosening the clamp screw.    (You will not need this assembly for the dual extruder setup.) 

Remove the Motor and Wiring Bracket 

6. Remove the (4) M3x10 screws holding the Wiring Bracket Cover in place.
Remove the Wiring Bracket Cover.
7. [image: ]Loosen the (3) M3x12 screws that secure the motor to the metal Motor Mount, so that the motor sits loose in the mount.  
8. There is a white connector for the motor that attaches to the harness inside of the Wiring Bracket.  You are going to disconnect the motor from the harness between the Bracket and the Motor.  

Slightly loosen/straighten the white connector wire to give yourself some working room.  It helps to have a fingernail to get underneath the lip on the white connector, or a thin flat screwdriver can help.  Gently separate the connector by pulling straight back on the raised lip towards the bracket.  (No catch on this one.)

9. Remove the motor (Motor 0) and set it aside for later use.
10. Remove the two screws securing the Bracket to the back of the metal Motor Mount.
11. [image: ]Turn the Bracket over and gently pull straight up on the wire connectors to remove them from the Bracket. (Snug fit…pry up from the black connectors, do not pull on the wires.)
12. Lay the Wire Harness (0) behind the machine for later use.

Remove Motor Mount, Mounting Plate, and Belt Clamp

1. Remove the (2) M3x12 screws from the metal Extruder Motor Mount.
2. Remove the (4) M2x16 screws from the Motor Mounting Plate, freeing it from the Belt Clamp.
3. Slide the Belt Clamp off of the X Belt.
             (You will not need these parts with the dual extruder setup.)   

[image: ]
Attach the Mounting Plate Assembly 

(1) Dual Mounting Plate (Assembled) 
(2) M3x8 screws, washers 
(1) Belt Clamp with nuts
(4) M2x16 screws, washers  



(Assembly tip:  Put a small piece of masking tape over the nuts embedded in the belt clamp to keep them from falling out during assembly.)
[image: ][image: ][image: ]

1. Place the belt clamp on the belt span nearest to the carriage with the fin under the back span. The belt clamp does not need to be in the same spot along the belt where the previous clamp was located.

2. Align the X-rail carriage with the clamp.  Place the extruder mounting plate on top of the belt clamp and carriage. 

3. Insert (4) M2x16 screws with washers through the back four holes of the extruder mounting plate to secure the belt clamp.  Tighten.

4. Push the plate back to press the small ledge on its underside against the front of the carriage; this helps to ensure that the two hot ends line up correctly in the Y direction.   Insert (2) M3x8 screws with washers through the back two holes of the X carriage that are not covered by the paper.  Tighten.






















Attach the Motor Bracket Assembly 

(1) Motor Bracket 
(6) M3x14 screws 
(4) washers 
(2) M3x18 screws, washers, lock washers 
[image: ](2) Extruder Motors— Motor 0 (original) and Motor 1 (new)   


1. Place lock washers followed by flat washers on (2) M3x18 screws.  With the flat part of the motor bracket to the rear, place it on top of the paper spacer, and use the screws to loosely secure it to the Mounting Plate and X Carriage. Use the plastic alignment piece to ensure that the bracket is parallel to the X rail. Tighten the M3x18 screws and remove the plastic alignment plate.


2. [image: ]Look at the face of your original motor (Motor 0) with the white connector at the top.  You will see one screw in the lower left hand corner.  Move that screw to the upper left corner.

3. With the white connector at the top, look at the face of the new motor (Motor 1).  Remove (3) M3x6 screws from the top left, bottom left, and bottom right of the new motor.                                                                            (You will not need these M3x6’s for the dual extruder setup).

4.  From behind, slide Motor 0 (original) into the left opening of the Motor Bracket with the connector at the top.  Insert (3) M3x14 screws with washers to secure Motor 0 to the Motor Bracket.  Tighten.

5. [image: ]Slide Motor 1 (new) into the right opening of the Motor Bracket with the connector at the top.  Insert an M3x14 screw with a washer into the bottom right hole and (2) M3x14 screws without washers into the left holes to secure the Motor to the Motor Bracket.  Tighten.





As you face the machine, the motor on your left will be Motor 0.  The motor on the right will be Motor 1.








Wiring

(1) Motor Wiring Bracket 
(2) Wiring Harnesses – Harness 0 (original) and Harness 1 (new) 
(2) M3x40 screws  
(5) Small Zip Ties 
[image: ](1) Fan Assembly  

1. Remove the borosilicate glass plate.  Lift off the Heated Bed Plate and set it behind the machine so you can see down.  Carefully raise the bed up to near the X gantry by lifting underneath the Y axis rail.  (Do not lift on the spider.) Tape the Z-axis knob into place to secure the bed into an elevated position.  (Or use one of the Z-knob stops designed for the purpose.)  Remove the SD card if it is in the drive.  



2. [image: ]Open the electronics case, by removing the three screws on the right side of the machine and carefully swinging the case forward in the direction shown.  The electronics fan remains attached to the top of the case – don’t damage the wires.  


3. Run the new wiring harness—Harness 1—through the back opening of the case. Look at the wiring harness that originally connected to the extruder motor—Harness 0—for reference.  Run the Harness wires underneath the existing harness wires
(The wiring for Harness 0 does not change from the single extruder assembly.)


4. Refer to the Wiring Diagram and photos on the next page to establish connections.  
Press connectors all the way down until they seat.


 	After making the three connections shown on the next page, replace the electronics cover and 
lower the bed.  
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     Assembly tip:  If you have a camera on your cell 
     phone, you can get a much better view of the 
     tiny print on the RAMBo board by looking at it 
     through the camera. 


















1. Plug the large 2-pin connector labeled Heat 1 from Harness 1 into the header labeled H1 on the RAMBo; it should be the only open header on the left side of the board.

2.  Plug the small 2-pin connector labeled T1 on Harness 1 into the T1 header on the RAMBo (in the rear of the board, in between the T0 and Bed Thermistor connectors).  This connector has no polarity. 

3. Plug the 4-pin connector labeled E1 from Harness 1 into the E1 motor header at the rear right side of the board behind the 4-pin connector labeled EXT from Harness 0.  (You will need to gently lift some wires to see the slot.)  Orient the connector so that the red wire is towards the front of the machine.   
[image: ][image: ][image: ]                                 













[image: ]Connecting the Wires

1. Connect the right motor (Motor 1) to the white motor connector (Ext 1) on the free end of the Motor 1 Wiring Harness.    Route the Thermistor and Heater Wires for Hot End 1 underneath, and to the left side, of Motor 0.

Connect the right thermistor wire to the Therm 1 connector on the harness, and the heater connector to the Heat 1 connector.

2. Connect the left motor (Motor 0) to the white motor connector on the free end of the original (Motor 0) Wiring Harness.

[image: ]Connect the left thermistor wire to the Ext connector  on the harness, and the heater connector to the Heat 0 connector.

3. Connect the wires from the Fan Assembly to the remaining slots on    Harness 0.  The Extruder fan (M2 Fan Guard) should be connected to the Fan 1 plug, and the angled 24V Bed fan should be connected to the Fan 0 plug. 

              The red fan wires should be routed to the left side of Motor 0 along with the 
              heater and thermistor wires from Hot End 1, above the mounting plate, 
              underneath Motor 1, and the Fan Assembly should be left to dangle behind 
              Hot End 1 on the right. 

4. Remove the (2) screws in the back of Motor 0 that are closest to Motor 1.   (Small Phillips head required.)
[image: ]
5. Snip the (4) zip ties that secure Harness 0 to the frame vertically on the
right side of the machine.  Reattach both harnesses into the same position using (4) new zip ties.  
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[image: ]Filament Drive Assembly  

Connect Filament Drive 1 (Right Side)  

(1) Motor 1 Filament Drive 
(2) M3 x 25, washers  

[image: ]Slide the Motor 1 Filament Drive onto the Motor 1 drive gear.   Rotate the filament drive until the hole for the filament at the bottom lines up with the hole on top of Hot End 1. Insert (2) M3x25 screws with washers through the top right and bottom left holes of the filament drive to secure it to the motor.  Make sure when tightening the screws that no wires are pinched between the filament drive and motor.  

One thing to watch for, the filament drive needs to sit flush against the flat face of the motor, with the drive completely surrounding the little raised circular rim around the pinion gear.  But the ABS drive might be a little tight – it tends to shrink.  If you can’t fit the drive flush against the face of the motor, use an Exacto knife to shave just a hair off of the very edge of the drive where shown, until the drive fits flat.
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Connect Filament Drive 0 (Left Side) 

[image: ](1) Motor 0 Filament Drive 
(2) M3 x 25, washers  

Before attaching Filament Drive 0 to the motor, place the wires of Hot End 0 into the hook at the bottom of the filament drive.  

Slide the filament drive onto the Motor 0 drive gear. Rotate the filament drive to line the filament hole up with the hole on top of Hot End 0.  Insert (2) M3x25 screws with washers through holes in the top left and bottom right positions to secure it to the motor.  When tightening the screws make sure that no wires are pinched between the two parts.

Attach the Cable Cover Bracket
[image: ]
(1) Cable Bracket
(2) M3x40 screws


Place the front lip of the Cable Bracket in front of the white connectors on top of the motors.  Tuck the wire connectors on the left of Motor 0 into the larger space on the bracket that swings down alongside Motor 0.  Tuck the wires connecting the hardware into the channel along the left side.

[image: ]Slowly swing the cable bracket down over the connectors and wires, making sure to tuck all of the wires and harnesses into the channels before tightening it down.

Attach the bracket to the two empty screw holes in the rear of Motor 0, with (2) M3x40 screws.
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Fan Duct Assembly  

(2) M3 x 30, washers  


Slide the nose of the Fan Duct between the filament drives.   Insert (2) M3x30 screws with washers through the two holes on the sides of the assembly to secure it to the filament drives and motors. 

Neaten up the wires by routing them through the hooks on the printed fan duct between the two fans to the hook in Filament Drive 1.  (optional)

[image: ]
(Note:  the right fan is supposed to be at an angle.)










[image: ]
Right Filament Guide 

(1) Right Filament Guide  
(1) M3x14 screw and washer

Remove the M3x12 screw from the back right corner of the X Motor. 
Secure the Right Filament Guide into this position using the supplied M3x14 screw and washer.            



[image: ]Right Spool Holder  

(1) Spool Holder 
(2) M4 x 16 screws, nylock nuts, black washers  

Place a black washer on each of the (2) M4x16 screws.  

Place the spool holder into position on the right side of the printer with the 
straight edge pointing towards the front,  and the top hole of the holder 
aligned with the middle hole on the frame.  Attach with screws and nylocks.


Testing and Settings

Flash the Firmware

1.  Download the tested version of Arduino (v1.5.5) based on your operating system from one of the links below:

	Windows :  http://arduino.cc/download.php?f=/arduino-1.5.5-r2-windows.zip
	Mac OSX:  http://arduino.cc/download.php?f=/arduino-1.5.5-macosx.zip
	Linux 32bit:  http://arduino.cc/download.php?f=/arduino-1.5.6-r2-linux32.tgz
	Linux 64bit:  http://arduino.cc/download.php?f=/arduino-1.5.5-linux64.tgz

    	Extract the file contents and install the software.  (Arduino IDE is used to flash the firmware to the M2.)

2.  Download the zip file for the M2 Dual Extruder Firmware here:
     
http://makergear.wikidot.com/m2-firmware

               For the M2 Rev. E  choose:
	http://makergear.wdfiles.com/local--files/m2-firmware/M2E-Production-SnNRd-V100.zip

 Extract the file contents.

3.   Plug in the M2 printer and power it on.  Connect the USB cable from the machine to the computer (if needed) 
and make note of the  COM port that it is attached to. 
 (In  Windows :   Settings > PC Info > Device Manager > Ports (COM & LPT) > 3D Printer powered by RAMBo ) 
Open the Arduino IDE, and go to the Tools menu. There, make sure that "Arduino Mega or Mega ADK" is selected in the Board submenu, and that the COM port relating to your M2 is selected in the Port submenu.
[image: ][image: ]


[bookmark: _GoBack]



Go to File > Open, and navigate to the location where you extracted the firmware.  Open Marlin.pde (or Marlin.ino) in the Marlin subfolder.   
Once Marlin has been opened, click on File > Upload.   The firmware should compile and upload to the RAMBo board.
Set the Tension in the Filament Drive Screws

The last step is testing the extrusion and setting the correct tension in the Filament Drive Screws for both drives.  The tension should ideally be just firm enough to catch the filament and guide it through, without smashing it in any way, since that will cause problems with jamming and stripping the filament.  Start with the tension fairly loose.

Insert filament into one of the drives, heat that nozzle up to the correct temperature for that filament, and use the jog controls in your slicer to extrude about 100 mm of filament, in batches of 10-20 mm at a time.  Make sure the filament is feeding into the drive.  (After 60 mm have been extruded, you should start to see the filament coming out of the nozzle).  Once that happens, retract the filament completely and examine the end that was pushed into the gear.
[image: ]


Look at the diagram to determine how to adjust the tension on the screw.
















Repeat the above steps, adjusting by 1/8th turn of the screw at a time, until your bite marks match the green strand.  
Then perform the same process for the other filament drive.  You can mark the correct tension with a spot of paint in the 12:00 position, so that it’s easy to set in the future.  

(Always adjust the tension when switching between different types of filament.  It prevents jamming & stripping.)
[image: ][image: Filament Ends.jpg]














Some Handy Links



MakerGear:  (makergear.com)

How to contact MakeGear Support:     http://www.makergear.com/pages/support
M2 (Github) Printable Parts:   https://github.com/MakerGear/M2/tree/master/Printed%20Parts/STL/V4%20Hotend
M2 Dual Wiki:  http://makergear.wikidot.com/dual#toc1


MakerGear Forum:  ( forum.makergear.com)

M2 Dual Extruder Forum:      http://forum.makergear.com/viewforum.php?f=13
Tech Support:    http://forum.makergear.com/viewforum.php?f=7
How To/ Guides/ Tips:    http://forum.makergear.com/viewforum.php?f=3
Filament Forum:       http://forum.makergear.com/viewforum.php?f=11


Simplify 3D:  (simplify3d.com)

Unofficial  Guide:     http://jinschoi.github.io/simplify3d-docs/
FFF Settings Window Tips:     https://forum.simplify3d.com/viewtopic.php?f=8&t=2367
User’s Forum:    https://forum.simplify3d.com/
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